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ADDENDUM TO  

N W A  Q U A L I T Y  A N A L Y S T  

User’s Manual 

This addendum contains changes to the NWA Quality Analyst User’s 

Manual. The page numbers in this addendum refer to the most recent 

edition of the User’s Manual. If you have an earlier edition, use the page 

numbers in the square brackets. You have an earlier edition if the last 

page is page 560. 

Page 9 

 Add the following text at the end of the section titled Managing Data Sets. It 

describes new file-management commands available on the File menu. 

To make managing Data Sets easier, Quality Analyst includes several file-

management commands, all of which appear on the Utilities submenu of 

the File menu. 

To copy a Quality Analyst Data Set: 

1 Open the File menu, select Utilities, then select Copy. The Copy 

Files dialog box will appear. 



Northwest Analytical, Inc.  NWA Quality Analyst User’s Manual 

Addendum to NWA Quality Analyst User’s Manual 2 

 

2 Specify the Data Set you want to copy in the upper half of the 

dialog box. 

3 Select a destination folder in the lower half of the dialog box. 

4 Click Copy. 

To delete a Data Set: 

1 Open the File menu, select Utilities, then select Delete. 

 

2 In the Delete Files dialog box, specify the Data Set you want to 

delete. 

3 Click Delete. 

To rename a Data Set: 

1 Open the File menu, select Utilities, then select Rename. The 

Rename Files dialog box will appear. 
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2 Specify the Data Set you want to rename in the upper half of the 

dialog box. 

3 Select a new name for the Data Set in the New File Name box. 

You need not supply a file name extension; Quality Analyst will 

apply the appropriate extensions for each component of a Data 

Set. 

4 Click Rename. 
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Page 28 

 The Variable Definition and Specifications dialog box has two new buttons 

labeled Print and Printer. This dialog box is also depicted on pages 33, 43, 
and 58. 

 

Page 46 

 Replace the section titled Saving the Data Definition with the following 

section. 

Printing and Saving the Variable Definition 
After you have specified all variables, click Print if you want to print the 

variable definitions and specifications. (Click Printer, if necessary, to 

make sure your printer is configured properly.) 

To save the data definition, click OK. The Editor will display a data grid 

much like a spreadsheet. The labels in the column headings will reflect the 

data structure you just defined. 
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Page 47 

 The Column Definition and Calculations dialog box has two new buttons 

labeled Print and Printer. This dialog box is also depicted on pages 49, 55, 
59, 429 [418]. 

Page 55 

 Replace the text in the section titled Saving the Data Definition with the 

following heading and text. 

Printing and Saving the Column Definition 
After you have specified all column definitions and calculations, click 

Print if you want to print them. (Click Printer, if necessary, to make sure 

your printer is configured properly.) 

To apply the column definitions and calculations, click the OK button. 

The Editor will display a data grid much like a spreadsheet. The labels in 

the column headings will reflect the data structure you just defined. 

Page 61 

 Insert the following procedure before the section Modifying Data. 

To move to a specific data cell: 

1 Open the Edit menu and select Go To. 

2 In the Go To A Data Cell dialog box, enter the row number and 

column number of the cell you want to select. 
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3 Click OK. 

Page 66 

 Insert the following section before the section Overriding an Input Mask. 

Finding and Replacing Data 

To find a cell based on its contents: 

1 Open the Edit menu and select Find. The Find dialog box will 

appear. 

 

2 In the Find box, enter the text you want to search for. 

3 In the Search box, select By Rows to search each cell in a row 

before moving to the next row. Select Current Column to search 

the column containing the selected cell. 

4 In the Search Direction area, specify whether to search Up from 

the current cell toward the top of the file or Down from the 

current cell toward the bottom of the file. 

5 In the Matching area, select Case Sensitive to find only those 

cells where the text and the case of the text matches your Find 

text. Select Entire Cell if you want to find only entire cells, not 

partial cells, that match your find text. For example, if you select 

this option and your find text is “BIN1,” Quality Analyst will find 
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only cells whose entire content is “BIN1” but not cells whose 

entire content is “BIN14” or “PARTBIN1.” 

6 Click Find Next to select the next cell that meets the criteria 

specified in the dialog box. 

To find and replace text in a Data Set: 

1 Open the Edit menu and select Find & Replace. The Find and 

Replace dialog box will appear. 

 

2 Specify the Find text and search parameters as explained in the 

previous procedure. 

3 In the Replace With box, enter the text that should replace the 

found text in the Data Set. 

4 Click Find Next to find the Find text in the Data Set. 

5 If the Find text is found, do one of the following: 

 Click Find Next to retain this occurrence of the found 

text and find the next occurrence.  

 Click Replace to replace this occurrence of the found 

text with the Replace With text. Repeat until you have 

made all desired changes in the Data Set. 

 Click Replace All to replace all remaining occurrences 

of the Find text with the Replace With text. 

6 Click Close to stop finding and replacing. 
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Page 93 

 Replace the figure at the top of the page with this one: 

 

 Add the following text to the end of the first paragraph. 

In the box labeled Number of Rows per Page, enter the maximum 

number of data rows to print on a page. Quality Analyst will start a new 

page after this many rows, even if more would fit. If you request more 

rows than would normally fit on the page, this setting is ignored. 

 Insert the following paragraph between the third and fourth paragraphs. 

In the Data Set Information area of the dialog box, specify whether you 

want to Print Variable Definitions, Print Column Definitions, or Print 

File Parameters on the report. 
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Pages 195 and 197 [194 and 196] 

 Replace the figure on these pages with this one: 

 

Page 199 [198] 

 Between the last two paragraphs in the Date Format section, add this text: 

In the Century area, specify the 100-year period in which your Quality 

Analyst data was or will be collected. Quality Analyst will use this setting 

to interpret dates in Data Sets that contain two-digit years. For example, if 

you enter 45, Quality Analyst will interpret the date 9/23/23 as 

9/23/2023, not 9/23/1923. (Quality Analyst interprets four-digit years 

in dates explicitly.) 
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Page 223 [222] 

 Replace the File Paths section with the following text and figure. 

File Paths 
On the File Paths tab of the Quality Analyst Settings dialog box, 

specify where, on your computer system, Quality Analyst should store 

temporary and graphics files.  

 

File Paths tab of the Quality Analyst Settings dialog box 

In the area labeled Temporary file path, specify the path where you want 

to store temporary files that are used “behind the scenes” by Quality 

Analyst. You may be able to improve the performance of Quality Analyst 

by specifying a RAM disk or a location on your network server or 

workstation that has a quicker response than the disk where you keep your 

data files. (If you choose a location on your network, make sure no other 
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Quality Analyst users are using it for the same purpose, or conflicts may 

arise.)  

In the area labeled Graphics (*.PLT) and Text (*.PTX) file path, 

specify the path where you want Quality Analyst to store graphics (PLT) 

files and text (PTX) files as it creates and displays them. Quality Analyst 

will store temporary files in this location unless you rename and save them 

to a different location as described under Saving Charts on Disk on 

page 147 [146]. 

To specify a path: 

 Select the upper box and leave it empty to store files in the same 

folder as your data (DAT) files.  

 Select the upper box and enter a path to an existing folder to store 

files there.  

 Select Use System Temporary File Path to use the folder 

specified by the TEMP= statement in your AUTOEXEC.BAT 

file. The name of that folder is shown in the adjacent gray box. 

Page 353 [349] 

 Add the following section between the table and the CHART section. 

CALC 
The CALC command calculates calculated variables, if any, in a Data Set. 

The syntax for the CALC command is: 

CALC filename.dat 

If your Data Set contains calculated variables and contains data that was 

added to the Data Set outside the Quality Analyst Editor (for example, by 

other data-collection software), you should include a CALC command in 

your Run File above any charting or analysis commands.  
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Example: To create an Individual and Range chart for a variable in a Data 

Set that contains a calculated variable, the Run File command lines would 

be: 

CALC VENEER.DAT 

IR VENEER.DAT THICK I R G 

Page 359 [354] 

 Add the following section after the $COMMENT section. 

CONNECT 
The CONNECT command is used by the Database Connectivity version 

of Quality Analyst to establish a connection to an external database. See 

Using Database Connectivity in Run Files on page 476 [465] for details. 

The syntax for the CONNECT command is: 

CONNECT filename.dat 

Page 391 [383] 

 Replace the syntax for a REPORT Run File command line with the following: 

REPORT [input file] [format file] [output] [output file] 

($PAGEWIDTH=n) 

  

Command Parameter Description 

[input file] the name of the input file 

[format file] the name of the report format definition file (see below) 

[output] “W” to create a formatted text (PTX) file 

[output file] the name of the output file 

($PAGEWIDTH=n) the number of characters per line of output 
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 Insert the following paragraph in the REPORT section before the example. 

You can control the width of a printed report by including a 

$PAGEWIDTH=n parameter on the REPORT command line. Substitute the 

number of characters per line of output (up to 240) for n (the default is 

120). 

Page 456 [445] 

 The External Database Setup dialog box, shown first on page 456 [445] and 

again on several subsequent pages in the chapter, has a new Options button 
between the Paste and Help buttons. 

 



Northwest Analytical, Inc.  NWA Quality Analyst User’s Manual 

Addendum to NWA Quality Analyst User’s Manual 14 

Page 461 [450] 

 Insert the following section just before the section Assigning Database 

Fields to Quality Analyst Variables. 

Setting External Database Access Options 
In the External Database Setup dialog box, clicking Options displays the 

External Database Access Options dialog box which lets you override, at 

the file level, several global connectivity options. This make it easier for 

your to connect to multiple database types. 

 

Select System Default to use the global settings. (Configuring these 

global settings is explained under Configuring Connectivity on page 23 of 

this Addendum. 

Select Custom to override the global parameters with the parameters you 

specify in this dialog box. The parameters will be saved for the current 

Data Set in its header (HED) file. 

For explanations of these settings, see Data Retrieval on page 25 of this 

addendum and Database Options on page 24 of this addendum. 
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Page 462 [451] 

 The Database Connectivity Definition dialog box, shown first on page 462 

[451] and again on several subsequent pages in the chapter, has changed. 

 

The table in the upper part of the dialog box now has three columns—the 

Quality Analyst variable name, the data type, and the field name from the 

external database. Earlier releases of Quality Analyst included a fourth 

column labeled Description. You can still enter or modify the variable 

description in the Variable Definition and Specifications dialog box which 

you display by opening the Edit menu and selecting Variable Definition 

and Specifications. 
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Page 467-472 [456-461] 

 Replace the section titled Defining Connectivity Data Filters with the 

following. 

Defining Connectivity Data Filters 
On the External Database Filter tab in the Database Connectivity 

Definition dialog box you can define filters to limit the amount of data 

retrieved from the data source. 

 

External Database Filters tab of the Database Connectivity Definitions dialog 
box 

(By default, Quality Analyst will retrieve the entire table from the data 

source when you open the Data Set.) The filter criteria you specify here 

become part of the data definition stored in the header file of the Data Set. 

When you open an external Data Set that includes filter criteria, Quality 

Analyst translates the criteria into SQL commands and sends them to the 
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external source so the data are filtered by the external source before being 

sent back to Quality Analyst.  

Note:  The External Database Filter tab is only accessible if your Data 

Set is based on a single table you selected from the drop-down list 

in the External Database Setup dialog box. If you chose 

instead to base your Data Set on an SQL query, the External 

Database Filters tab will not be available and the SQL commands 

you enter must perform all necessary filtering. 

When using connectivity filters, please note: 

 You can define any number of filter criteria. Only data records 

meeting all criteria will be returned to Quality Analyst. (That is, 

“AND” logic is used.) 

 Any External Database field assigned to the Quality Analyst Data 

Set may be used in a filter. 

 You can specify filters that return records with fields that match 

specific values or that fall within a range of values. (See 

explanations below.) 

 Filters based on a date field can be set to return records from a 

specified number of months or days ending today. 

 If you change the definition of the Connectivity Data Set, the 

External Database filter(s) will be cleared. Quality Analyst will 

warn you that, unless you redefine the filter before you click OK, 

the entire (unfiltered) table will be retrieved. 

 The Reset button clears (erases) all current filter criteria and 

reestablishes the lists of available fields (Columns). (You may 

need to click Reset to initialize the filters when you first create 

the Data Set.) 

Defining Filters to Retrieve Matching Data 

To define a connectivity filter to retrieve matching data: 

1 Click New and select the database field on which you want to 

base the filter.  
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The field name will appear in the list of Filters on the left and in 

the Column box. 

2 Select Match. 

3 Enter the value to match in the adjacent box. 

Here is an example of a match filter that will retrieve only data produced 

on June 1, 1997. 

 

Example of a matching-data filter 

Defining Filters to Retrieve Similar Data 

To define a connectivity filter to retrieve similar data: 

1 Click New and select the database field on which you want to 

base the filter. The field name will appear in the list of Filters on 

the left and in the Column box. 

2 Select Like. 

In the adjacent box, enter the string you want to search for, using question 

marks and asterisks as “wild cards.”  Use a question mark (“?”) to 

represent any single character and an asterisk (“*”) to represent one or 

more characters. 
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Here is an example of a filter that will retrieve only data records in which 

the BATCH field begins with 1178-, ends with -A, and contains any 

three characters in between. 

 

Example of a similar-data filter 

Defining Filters to Retrieve Ranges of Data 

To define a connectivity range filter: 

1 Click New and select the database field on which you want to 

base the filter. The field name will appear in the list of Filters on 

the left and in the Column box. 

2 Select From. 

3 Select a lower-limit condition from the adjacent drop-down list: 

 Select “=” to include records where the field value is 

exactly equal to the lower limit.  

 Select “>” to exclude records where the field value is 

exactly equal to the lower limit. Values “just greater 

than” the lower limit will be included. 

4 Enter the lower limit of the desired range in the adjacent box. 

5 Next to To:, select an upper-limit condition from drop-down list: 

 Select “=” to include records where the field value is 

exactly equal to the upper limit.  

 Select “<” to exclude records where the field value is 

exactly equal to the upper limit. Values “just less than” 

the upper limit will be included. 

Here is an example of a range filter that will retrieve only data collected 

during June 1997. 
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Example of a data-range filter 

You can define an “open-ended” range filter by leaving either the To or 

the From entry blank. Here is an example of a range filter that will 

retrieve only data collected before June 30, 1997 (“To <”).  

 

Example of an “up to” data-range filter 

Here is an example of a range filter that will retrieve only data collected 

on or after June 30, 1997 (“From =”). 

 

Example of an “above” data-range filter 
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To define a “preceding period” connectivity filter: 

1 Click New and select the database field on which you want to 

base the filter. The field name will appear in the list of Filters on 

the left and in the Column box. 

2 Select During the last  month(s) or During the last  

day(s).  

Enter a number of months or days (including today) in the corresponding 

box. 

Here is an example of a “preceding period” filter that, if executed on 

June 30, 1996, would retrieve only data collected from June 24 through 

June 30, 1997. 

 

Example of a “preceding period” filter 

Removing Filters 

To remove a connectivity filter: 

1 Select the filter in the list of Filters at the far left of the dialog 

box. 

2 Click Remove below the list. 

Sorting Filtered Data 

In the Order By area of the External Database Filters tab, you can specify 

the how you want the retrieved table to be sorted when it is brought in to 

Quality Analyst. You sort the data on up to three keys in either ascending 

or descending order. 
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To sort filtered data: 

1 Select from one to three sort keys from the drop-down lists. 

2 In the Sort Order area, select Ascending or Descending order. 

The specified order will be applied to all three keys. 

 

Page 477 [466] 

 Insert the following section just above the Examples section. 

The CALC Command 
If the data definition for your connectivity Data Set includes calculated 

variables, you should include a CALC command after the CONNECT 

command to ensure that the calculated variables are updated to reflect any 

new or changed data in the external database. 

 Insert the following new example between the two existing examples in the 

Examples section. 

In the following Run File, the data for the Data Set named PLATES, 

which contains calculated variables, is downloaded and calculated before 

it is used to create an IR chart: 

CONNECT PLATES.DAT 

CALC PLATES.DAT 

IR PLATES.DAT THICK I R G 

CHART 
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Page 478-484 [467-473] 

 Replace the Configuring and Troubleshooting section through the 

[ODBC] section with the following: 

Configuring and Troubleshooting 
Quality Analyst with Connectivity was designed to connect to a wide 

variety of data sources under many circumstances. Setting up the initial 

connection can be a complex task that may require some trial and error. 

Quality Analyst with Connectivity is highly configurable and lets you 

meet the requirements of many different data sources and connection 

techniques. 

Quality Analyst with Connectivity uses the same database “engine” 

(named “Jet” by Microsoft) as Microsoft Access. This provides a number 

of distinct advantages in flexibility and performance, but also affects 

configuration (see Microsoft Access / Jet Database Engine on page 486 

[475]).  

You can configure most of the parameters that control and help debug 

external database connections on the Connectivity tab of the Quality 

Analyst Settings dialog box. These are explained below under 

Configuring Connectivity. 

Other parameters that control Connectivity configuration are stored in the 

QAEDIT.INI file, which you may edit directly to make necessary changes 

(see The QAEDIT.INI File on page 28 of this addendum). 

Configuring Connectivity 
To configure Connectivity, click Settings on the main Quality Analyst 

start-up screen. In the Quality Analyst Settings dialog box, select the 

External Database tab. This tab contains areas labeled Database 

Options, Data Retrieval, Database Debugging, ODBC Settings, and MS 

Jet Database Engine. 
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Database Options 

When connecting to an external database, Quality Analyst can either open 

the database, or attach the external database tables to a temporary database 

created by Quality Analyst. It may seem roundabout for Quality Analyst to 

create a temporary database and attach tables, but there can be advantages 

depending on the particular database and type of connection used.  

Opening Databases 

To open the external database select Open Database. If you choose this 

option, select Pass SQL to Database for Processing if you want to 

pass Structured Query Language (SQL) queries to the external database 

for evaluation. Clear this check box if you want the Jet Database Engine 

to evaluate SQL queries. 

Despite (or perhaps because of) many SQL “standards,” each database has 

its own unique SQL syntax. Jet Database Engine SQL matches Microsoft 

Access SQL. If the Jet Database Engine interprets the query, Microsoft 

Access can be used to create the SQL statement. Also, if the Microsoft Jet 

2.0 / Visual Basic 3.0 Compatibility Layer is installed, the query can be 

optimized using the Rushmore data-access technology. 



Northwest Analytical, Inc.  NWA Quality Analyst User’s Manual 

Addendum to NWA Quality Analyst User’s Manual 25 

If the query is passed on to the external database for evaluation, functions 

unique to its SQL can be used. You can also use the passthrough setting 

when the table or field names of the external database don’t match the Jet 

Database Engine naming restrictions. 

Attaching Databases 

To attach external tables to a temporary database, select Attach Tables to 

Temporary Databases.  

Table and field names in remote databases don’t always match the 

Microsoft Jet Database Engine syntax. In some databases, the table name 

has a prefix consisting of an “owner” name and a period. Whereas the Jet 

Database Engine expects database field names in the form “table.field”, 

these databases return “owner.table.field.” If you select Modify Table 

Names for Jet Engine., Quality Analyst will try to modify the internal 

table names so they are acceptable to the Jet Database Engine 

(“owner.table” is changed to “owner_table”). If an SQL query is used, it is 

also modified. 

Note: The “Jet 2.0 / Visual Basic 3.0 Compatibility Layer” will also 

resolve these syntax problems. If the Compatibility Layer is 

installed, this setting has no effect. 

Saving the Password with a Data Set 

If your external database is password-protected, select Save Password 

with Data Set if you want to save your user name and password in the 

header (.hed) file of the Data Set. When you subsequently open the Data 

Set, Quality Analyst will retrieve the user name and password from the 

header file rather than ask you to enter it each time. This applies to normal 

use and in Run Files containing commands that access the external 

database. This setting can be a time-saving convenience but can also pose 

a security risk since the user name and password are stored in an ASCII 

file and are not encrypted. 

Data Retrieval 

In the area labeled Data Retrieval, select Snapshot to return actual data 

records from an external database to Quality Analyst. Select Dynaset to 

return keys to database records instead of the actual records. 
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Either setting will work with any access method. Which technique is 

fastest depends on factors outside the scope of Quality Analyst. Only by 

experimenting with both can you determine the fastest technique. The 

results may, in fact, be nearly identical. 

Database Debugging 

In the area labeled Database Debugging, select Debug Window if you 

want Quality Analyst to display a dialog box containing details of each 

database command before the command is issued. This method is tedious 

to use, but provides immediate feedback on each step of database 

connectivity 

Select Debug Logging if you want Quality Analyst to write details of 

each database command to a log file. 

See Debug and Message Logging on page 492 [481]. 

Note: To view the log file, select About Quality Analyst from the Help 

menu of the Quality Analyst Editor, and click the Show Debug 

Log button. You can print the log or copy it to the Clipboard. 

Northwest Analytical technical support will often ask that you fax 

or e-mail them a copy of the log. The log file is cleared when you 

exit Quality Analyst. 

ODBC Settings 

In the area labeled ODBC Settings, enter timing parameters for ODBC 

(Open DataBase Connectivity) connections. 

In the Login Timeout box, enter the number seconds Quality Analyst 

should wait for the ODBC database to respond before canceling the 

attempt to connect to the database. 

In the Query Timeout box, enter the number seconds Quality Analyst 

should wait for the ODBC database to respond to a query before canceling 

the query. 

In the Connection Timeout box, enter the number of seconds Windows 

should keep the ODBC connection open after Quality Analyst requests it 

to close. The default setting is 1 second. If you enter 0, the ODBC 
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connection will remain open until you close Quality Analyst. Windows 

does this because it’s more “efficient” if the connection is reopened a 

second time. During the time Quality Analyst has an open ODBC 

connection, applications that require exclusive use of the external database 

cannot run. Setting this parameter to one second reduces the potential for 

conflict. 

MS Jet Database Engine 

The area labeled MS Jet Database Engine contains several settings that 

manage how Microsoft Access security affects Quality Analyst 

connectivity. 

If you select Use Access Security File, Quality Analyst will instruct the 

Jet Database Engine to use the Access System Database (often named 

SYSTEM.MDA). This file contains the permissions for all user 

identifications and passwords. The user’s identification and password can 

only be verified if this file is available. 

The Access System Database file may be in the NWA Quality Analyst 

directory where the Jet Database Engine can find it, but generally it is in a 

different directory. Select Always Ask for Access Security File if you 

want Quality Analyst to prompt you for the location of the Access System 

Database each time you connect to the database. If you leave this setting 

cleared, Quality Analyst will ask you once for its location the next time 

you connect to the database. After you enter its location, Quality Analyst 

stores it for subsequent use. (To change the location of this file later, 

return to this tab, select Always Ask for Access Security File, connect 

to the database, enter the location of the file when prompted, close the 

connection to the database, return to this tab, and clear the Always Ask 

for Access Security File check box again.) 

If you clear the Use Access Security File check box, user identifications 

and passwords cannot be verified, so you should clear the Access Logon 

check box (see below). No Access security will be used. 

It might seem that, by clearing the Use Access Security File and 

Access Logon check boxes and hiding SYSTEM.MDA, the entire 

security system can be circumvented. While this will allow the Microsoft 

Jet Database Engine to be used without a user identification and password, 



Northwest Analytical, Inc.  NWA Quality Analyst User’s Manual 

Addendum to NWA Quality Analyst User’s Manual 28 

Microsoft Access databases that were created with password security will 

not be directly accessible. 

Select Access Logon if you want Quality Analyst to send a user name 

and password to the Jet Database Engine. Enter the User Name and 

Password in the adjacent boxes. If you select Ask for Access Logon, 

Quality Analyst will prompt you for a username and password each time 

you connect to an external database. The current settings for User Name 

and Password, if any, will appear as defaults in that prompt.  

Before entering a User Name and Password here on the External 

Database tab, you should consider the security risk. Anyone using the 

computer can view these settings. If strict security is vital, leave 

Password (and maybe even User Name) blank and select Ask for 

Access Logon. 

The user name and password are used whenever the Jet Database Engine 

is started. Jet uses them with all external databases. In addition, with 

password-protected Microsoft Access databases, the user identification 

and password must have “read” permission for the database. 

If you clear the Access Logon check box, the Jet Database Engine will 

use “Admin” for User Name and nothing for Password. 

The QAEDIT.INI File 
The settings you specify on the External Database tab of the Quality 

Analyst Setting dialog box are stored in the file QAEDIT.INI in the 

\WINDOWS folder. There are several other connectivity settings in this 

file that apply to specific database types. You can modify these settings by 

editing QAEDIT.INI, an ASCII text file, using any text editor. Please note 

the following when modifying this file: 
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 Use an editor (such as Windows Notepad) that works only with 

plain ASCII text. If you must use a word processor such as 

Microsoft Word, make sure you save the file as pure text, with no 

formatting codes. (Because “full-featured” word processors can 

save “invisible” formatting codes that make an INI file unusable 

by its application, it is much safer to use a “dedicated” plain-text 

editor). 

 Use care. Quality Analyst reads the settings in this file each time 

it starts. Since Windows applications read their INI files on 

startup, you must close Quality Analyst, if it is running, and 

restart it for changes in QAEDIT.INI to take affect. 

Note:  If you use Quality Analyst under OS/2, you must reboot 

your computer for changes in QAEDIT.INI to take 

effect. 

 If the QAEDIT.INI file becomes damaged, you can restored it to 

its default condition by deleting it and restarting Quality Analyst. 

This will cause a fresh copy of QAEDIT.INI to be created with 

default settings. 

As with most INI files, QAEDIT.INI is divided into sections with labels 

enclosed in square brackets. The settings in each section consist of a 

keyword, an equals sign, and the value of the configuration parameter. 

The sections and additional parameters in QAEDIT.INI are: 

[Installable ISAMS] 

Paradox 3.X=PDX110.DLL 

Paradox 4.X=PDX200.DLL 

dBASE III=XBS110.DLL 

dBASE IV=XBS110.DLL 

FoxPro 2.0=XBS110.DLL 

FoxPro 2.5=XBS110.DLL 

 

[dBASE ISAM] 

Deleted=On 

 

[Paradox ISAM] 

ParadoxUserName= 

ParadoxNetPath= 

ParadoxNetStyle= 

CollatingSequence=Ascii 
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The following sections explain these parameters. 

Page 486 [475] 

 Ignore the section titled [Options]. 

 

 Add this note to the Microsoft Access / Jet Database Engine section: 

Note: Refer to the Setup and Tutorial guide for important information 

about installing and removing the Microsoft “Jet 2.0 / Visual 

Basic 3.0 Compatibility Layer” using the QACOMPAT.EXE 

program. 

Page 493 [482] 

 Replace the last paragraph and the rest of this section on the next page with 

the following text and screen shots. 

The debug log file is an ASCII text file and may be read by any editor or 

word processor. To display the debug log file in Quality Analyst, first 

open the Help menu and select About Quality Analyst. 
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Quality Analyst Help About dialog box showing Show Debug Log button 

Note: You can print the information in this dialog box or copy it to the 

Clipboard by clicking Print or Copy respectively. 

If Debug Logging is selected, this dialog box will include a Show 

Debug Log button. Click it to display the debug log file. 

 

Example debug log file 

To print the debug information, click Print. To copy the information to the 

Clipboard, click Copy. If you need technical assistance from NWA, 
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faxing or e-mailing this information to us may help us resolve your 

problem. 
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